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* Create a logic design from start to a DE10
implementation

* This example uses “best design practices”

* This example is not about creating HDL
 The HDL code will be provided without explanation
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e Design Hierarchy

* Name your testbench the same as your design file but add _tb to the end
* counter_8bit.vhdl = counter_8bit_tb.vhdl
» shift_reg nbit.vhdl = shift_reg_nbit_tb.vhdl

* When we start using the DE10 we will do the same thing

* Name your DE10 implementation the same as your design file but add _del0 to the
end

* counter_8bit.vhdl = counter_8bit_del0.vhdl
* shift_reg nbit.vhdl - shift_reg nbit_de10.vhdl

* |In both cases we never change the base design file

* Ensures what we designed is what we simulate, and what we simulated is what we build

foo_tb.vhdl foo_del0.vhdl
foo.vhdl Testbench with Design DE10 with Design File
Design File instantiated instantiated
File Design Design
File File
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* Flow

MyDesign_tb.vhdl

Specifications Design Verification Svnthesis
(Requirements) (Schematic or HDL) (RTL Simulation) y

MyDesign.vhdl \ MyDesign_de10.vhdl /

Verification
(Hardware)

Mapping
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Common

* Flow

Specifications Design
(Requirements) (Schematic or HDL)

Create project
Create HDL code
Verify RTL visually
Create testbench
Verify operation

Verification
(RTL Simulation)

Place &
Route

Verification
(Hardware)

Synthesis >| Mapp>

Create DE10 implementation HDL

Compile
Verify RTL visually
Program DE10 board

* Verify operation manually

5
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* Flow

MyDesign_tb.vhdl

\ /

Specifications Design Verification
(Requirements) chematic or HDL) (RTL Simulation)

Verification
(Hardware)

Synthesis Mapping

MyDesign.vhdl \ MyDesign_de10.vhdl /
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* Create a counter

* Binary wrapping count
* N bits
* Up/down

e Test the design using ModelSim

* Implement an 8 bit version on the DE10

e Reset and direction = switches
e Count value = LEDs
* Clock divider = 3Hz operation
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* Flow

MyDesign_tb.vhdl

/

Verification
(Hardware)

Specifications
(Requirements)

Verification
(RTL Simulation)

Synthesis Mapping

MyDesign.vhdl \ MyDesign_de10.vhdl /
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* Create a new Project

e Use the Quartus Project Setup notes as a guide

e Switch to Files view mode

Ok Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example

| L QOD

Eile Edit WView Project Assignments Processing Tools Window Help

D ~ G Setup_example
e —
Project Navigator = Files et L =

Files N—

E¥ Setup_examplesdc

Taskl Compilation MIEIE -
Task ~
v P Compile Design
> Analysis & Synthesis
P Fitter (Place & Route) w
< >

=
:‘ an| D A A A <<Filter=>
q

P OQAVE S

|IP Catalog g =

~ @ Installed IP
¥ Project Directory
Mo Selection Available
¥ Library
Basic Functions
DSP

® u
Quartus Prime
Memory Interfaces and Controllers

Processors and Peripherals

University Program
e Search for Partner IP

VE SR e Buy Software

(& X =

+ add.

Type ID  Message

Note: the correctly named
SDC file is visible if you

setup your project correctly

0% 00:00:00
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e Create a new HDL file

= d l

* File > New - VHDL File

Project Navigator @ Files

valga x

Files

58¢ Setup_examplesdc

Tasks Comipilation

Task
~ P Compile Design
> Analysis & synthesis

P Fitter [Place & Route)

<<Filters>

TSN ><|
z
Q
%
2>

Type ID Message

|Messa,ges

Systern Processing

O New

New Quartus Prime Project
V¥ Design Files
AHDL File
Block Diagram/Schematic File

EDIF File
Qsys System File
State Machine File

SystemVerilog HDL File
Tcl Script File

DL File

¥ Memory Files
Hexadecimal (Intel-Format) File
Memaory Initialization File

¥ Verification/Debugging Files
In-System Sources and Probes File

Logic Analyzer Interface File

signal Tap Logic Analvzer File

LR m Buy Software

~ b installed 1P

¥ Project Directory
No Selection Available

~ Library
Basic Functions
DsP
Interface Protocols
Memaory Interfaces and Controllers
Processors and Peripherals
University Program

e Search for Partner IP

+ Add..

- Cancel Help

0% 00:00:00

Common
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Use a reverse basis approach
so all designs with the same

basis are together in the file system
making them easier to find

counter_mod10

* Create a new HDL file counter_up_nbit
* Note — the default file name is Vhdl.vhd / counter_tpdn_non-urap_not
* File = Save As and give it an informational file name
e Change the file extension to vhdl (for VHDL files)

* Make sure “Add file to current project” is checked
MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example (¥ Quartus Prime Lite Edition - D:/GDrive/MSQE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_exa
sing Tools Window Help File Edit Wiew Project Assignments Processing Tools i
[ » 4 4 P y 4
sssss — - X-X<] > 9 Nr=d [ nile! - ]
aQ o E -
ML I Project Navigator ElFiles vags x| & ]
= =3 —— Lm - = — e — -
m® i = ="M L u §EENRNRB IS
1 1
2
3

New file is visible

ssssssssssssssss
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O

* Set the Top Level Entity
Right click on the design file in the Files window
Select Set as Top Level Entity

\k Quartus Prime Lite Edition - Di/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example

View Project Assignments Processing Tools Window Help

[ Bl

Project Navigator [El Fites - |Qipg x

&
-

E% Setup_exa

mp Counter u

Open

Remove File from Project

_-60{_;

Setup_example

R 22

boOadN 9

Counter_updn_n_bit.vhdl

|IP Catalog

o,

YRR

¥ il installed 1P

¥ Project Directory

* Library
Basic Functions
DsP

Interface Protocols

Memory Interfaces and Controllers

Processors and Peripherals
University Program

e Search for Partner IP

E  set as Top-Level Entity Crl+Shift+V
Create AHDL Include Files for Current File
Create Symbol Files for Current File
Create Verilog Instantiation Template Files for Current File
Create VHDL Component Declaration Files for Current File
Properties...
18
P Analysis & Synthesis 19
20
P Fitter (Place & Route) 21
Q| &) (4] [A] [F <Fiter 8 Find..

+ Add.

|||-a:.mx‘n

ID  Message

Messages

Processing

Sets the current file entity as the top-level entity for the next compilation




* Enter your design

G Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example — O X

File Edit View Project Assighnments Processing Tools Window Help Search altera.com |ﬁ
D ~ El ﬂ Setup _example T =-' 96@ ’ ' ’,0 ei‘i »—d ’

Project Navigator E Files o Re x ¢ Counter_updn_n_bitvhdl B ‘IP Catalog pax
i = = = 267 — x| =
Files ] == Dm‘m) L[D._’D 268 = |.~_

T® Counter_updn_n_bitvhdl 1 Eo—— - m e m o C o ______ v 4 Installed IP
Z8 Setup_example.sdc 2 - . % Project Directory
431 - Counter_updn_n_bit.vhd] No Selection Available
5 -- created 6/22/18 v Library
!75 -- 1 Basic Functions
8 |--revo DsP
o —---—------——— o Interface Protocols
10 --
11 -- n bit up/down counter example o MemoryInter‘faces.andCOntrollers
12 |-- for showing a project from start to finish Processors and Peripherals
ig - University Program
15 | -- © Search for Partner IP
16 -- Inputs: rsth, clk, dir
Tasks Compilation =l x| 17 |-- Outputs: cnt
18 --
Task TN 19 | mmm e
v P> Compile Design e - -
P g 21 | -- counts up when dir = 0
P> Analysis & Synthesis 22 | -- counts down when dir = 1
. 25 --
P> Fitter (Place & Route) wil2d b
> < S + Add..

Blal (O A4 A <<Filter>> @8 Find.. | | #8Find Next

1

= rvhe T Messane

© 125068 Revision "Setup_example” was previously opened in Quartus II software version 18.0.0 Lite Edition. Created Quartus
© 125069 Default assignment values were changed in the current version of the Quartus Prime software -- changes to default 3

v

&

g < >

(%)

i’ System (2) Processing

0% 00:00:00
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Follow the “best practices” — see web site
i_, o_ for signals in/out of the block
std logic for wires - signed, unsigned for signals
almost everything in a process
generic whenever possible

- narchitecture behavioral of Counter_updn_n_bit 1is
-- Counter_updn_n_bit.vhdl

- 1l -

-- created 6/22/18 -- 1internal signals

R t - _

- ] signal cnt_sig: unsigned(n-1 downto 0);
-- rev 0 i .
________________________________________ ibegin

-- n bit up/down counter example i process(i_clk, 1i_rsth)

-- for showing a project from start to finish begin

[ :| -_
________________________________________ -- reset

-- Inputs: rstb, clk, dir i if (i_rstb = "0') then
-- Outputs: cnt cnt_sig <= (others => '0');

[ H -

________________________________________ -- rising clk edge

-- counts up when dir = 0 i elsif (rising_edge(i_clk)) then
-- counts down when dir = 1 i if(i_dir = '0") then

-- i cnt_sig <= cnt_sig + 1;
________________________________________ i else

Tibrary 1ieee; cnt_sig <= cnt_sig - 1;
use ieee.std_logic_1164.all; B end if;

use jeee.numeric_std.all; I end if;

end process;
entity Counter_updn_n_bit s

generic( i -- _
n: natural := 8 i -- Output logic

pért ( o_cnt <= std_logic_vector(cnt_sig);
i_clk: in std_logic; .
i_rstb: in std_logic; rend behavioral;
i_dir: in std_logic;
o_cnt : out std_logic_vector(n-1 downto 0)

J;

Comr€nd entity;




Common

* Enter your design

* Create a component template for your design (DUT)
e Used in your testbench and DE10 files

e Select File 2 Create/Update = Create VHDL Component
Declaration Files from Current File

Copyright (C) 2017 Intel Corporation. All rights reserved.

-- Your use of Intel Corporation's design tools, logic functions

-- and other software and tools, and its AMPP partner logic

-- functions, and any output files from any of the foregoing

-- (including device programming or simulation files), and any

-- associated documentation or information are expressly subject
-- to the terms and conditions of the Intel Program License

-- Subscription Agreement, the Intel Quartus Prime License Agreement,
-- the Intel FPGA IP License Agreement, or other applicable license
-- agreement, including, without limitation, that your use is for

-- the sole purpose of programming logic devices manufactured by
-- Intel and sold by Intel or its authorized distributors. Please

-- refer to the applicable agreement for further details.

-- Generated by Quartus Prime Version 17.1 (Build Build 590 10/25/2017)
-- Created on Fri Feb 23 09:52:29 2018

15

COMPONENT Counter_updn_n_bit

PORT

(
i_rstb : INSTD_LOGIC;
i_clk : INSTD_LOGIC;
i_dir : INSTD_LOGIC;

o_cnt :  OUTSTD_LOGIC_VECTOR(7 DOWNTO 0)
);
END COMPONENT;

© tj



e Elaborate

* Check the design syntax and create RTL
e Processing = Start = Start Analysis and Elaboration

Fix all Erro

Common

(O Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Commaon_Preject/Setup_example - Setup_example

File Edit View Project Assignments Processing Tools Window Help
N ’ ’ n
: Sety I - 4 1 1 i!i 1 ,
= d ) up_ecample /GSQOUP+ QAR
Project Navigator E Files v @ f/@ x| 4F counter_updn_n_bit vhdl @ Compilation Report - Setup_example [£ |IP Catalog R x
Files Table of Contents U Flow Summary “ x| =
el Counter_updn_n_bitvhdl EB Flow Summary @, <<Filter>> hd J Installed IP
E® Setup_examplesdc FA Flow settings Flow Status Successful - Fri Jun 22 18:3 * ¥ Praject Directory
E= Flow Mon-Default Global Settings Quartus Prime Version 18.0.0 Build 614 04/24/201
BB Flow Elapsed Time Revision Name Setup_example ~ Library
FA Flow os Summary Top-level Entity Name Counter_updn_n_bit Basic Functions
E Flow Log Family MAX 10 osP
Analysis & Elaboration Device 10M50DAF484C7G Interface Protocols
Tasks Compilation T =lge = O Flow Messages Timing Models Final Memary Interfaces and Controllers
Task 0 O Flow suppressed Messages Total logic elements M/A until Partition Merge Processors and Peripherals
v P Compile Design Total registers MN/A until Partition Merge University Program
Total pins M/ A until Partition Merge
v P Analysis & Synthesis L i @ searchfor Partner IP
m Total virtual pins N/A until Partition
Edit Settings H
d il ||zt e e win - SOMeE Of these warnings are due to the fact that
» we included the QSF file even though
a | a (O & A (A S Find.. | 88 Find Next . . e ) .
E we are not using this file for the basic design
=| Type ID Message
o » .
o RUNNing Quartus Prime Analysis & Elaboration
o command: quartus_map --read settings_files=on --write_settings_files=off Setup_expiple -c Setup_example --analysis_and_elaboration
' 18236 Number of processors has not been specified which may cause overloading on shapdd machines. Set the global assignment NUM_PARALLEL PROCESSOI
o 20030 Parallel compilation is enabled and will use 2 of the 2 processors detected
) 12021 Found 2 design units, including 1 entities, in source file counter_updn_nAit.vhdl
o 12127 Elaborating entity "Counter_updn_n_bit" for the top level hierarchy
' 20013 1gnored 185 assignments for entity "DELO_Lite"” -- entity does not exist in design
o quartus Prime analysis & Elaboration was successful. 0 errors, 187 warnings . II .
Review all Warnings
2
g Systemn (1) Processing (3)

100% 00:00:43 ‘

16
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 Verify the RTL
* Tools = Netlist Viewers =2 RTL Viewer

b7 b6 b5 b4 b3 b2 b1 b0 ‘1’
+1 111 11101

; Bk Counter Register
Keep top 8 bits Down - Subtractor /
Effectively adds -1 o _cnt[7..0]
i_C“(D // Cﬂ{SigDU] - i
i_dir[ > D
QT 1h0 CIN_\ Add1 cnt_sig~[7..0] 8'h0 S
I~ A[8.0] m OUT[8.0] 0 _SCLCFERN
Oh1fd Bls.0] Sl 1 T
ThOcan  AddO
AT7.014 A 0uT17.0) \
81 B7.0] S N
i_rsth[ > % Up / Down Selector
Up - Adder
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* Flow

MyDesign_tb.vhdl

Specifications Design Verification Ao Verification
(Requirements) (Schematic or HDL) (RTL Simulation) apping (Hardware)
MyDesign.vhdl \ MyDesign_de10.vhdl /
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This should be the same name as
your design file with _tb added

* Create Testbench S———
* File > New - VHDL File e
* File = Save As and give it an informational file name

(¥ Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example

File Edit View Project Assignments Processing Tools Window Help
. » » n
Ve Set I - i i i!ﬁ 1 ’
Nr=d 2 m— / SEOT> + QA
Project Navigator E Files rape =| @ Compilation Report - Setup_example @ Counter_updn_n_bit_tb.vhdl* |IP Catalog pa =
Files = 60 {—i == g L[l:l - 267 = (o
. = [ - 268 =
Em Counter_updn_n_bit_tb.vhdl 1 v i Installed IP
~
E% Counter_updn_n_bit.vhdl % ¥ Project Directory
m Setup_examplesdc 4 No
5
6 v Library
7
8 Basic Functions
9
10 DSP
i% Interface Protocols
ilati v =pax
[EEis Eoposoy = s Memory Interfaces and Controllers
14
Task ~ 15 Processors and Peripherals
16
v P Compile Design 17 University Program
18
v P analysis & Synthesis 19 e Search for Partner IP
20
W Edit Settings vl 21 v
< > < > + add.
x L]
g lan B A A A Mrind. | M Find Next
1
= || Type ID Message "
0 Running Quartus Prime Analysis & Elaboration
Fettings_files=on --write_settings_files=off Setup_example -c Setup_example --analysis_and_elaboration
been specified which may cause overloading on shared machines. sSet the global assignment NUM_PARALLEL_PROCESSOF

. . .« .
NeW flle IS VISIbIe ed and will use 2 of the 2 processors detected
ing 1 entities, in source file counter_updn_n_bit.vhdl
[) / aporating entity counter_updn_n_bit" for the top level hierarchy
1 20013 Ignored 185 assignments for entity "DELO_Lite" -- entity does not exist in design
o Quartus Prime Analysis & Elaboration was successful. 0 errors, 187 warnings

<

100% 00:00:04

|Message5

System (1) Processing (14)
© tj
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* Enter your TB

uartus Prime Lite Edition - 0:/GDrive/ /Common/Cuartus_Projects/Commeoen_Project/Setup_example - Setup_example -
& a Prime Lite Edition - D:/GDrive/MSOE/C [o! Projects/C Project/Setup ple - Setup pl | X
File Edit WView Project Assignments Processing Tools Window Help
4 4 4 i " :
: Ev— 7 2 @
Or=d " pg— /SSOUP + O AOE
Project Navigator E Files ~af@e x| & Compilation Report - Setup_example ¢ Counter_updn_n_bit_tb.vhdl* [ |IP Catalog g x
Files = w {_i = = T ] 267 — |Q X| =
. == == 268 — -
B Counter_updn_n_bit_tb.vhdl v @ Installed IP
- Hpn_n_bIL T HF-—-————mmmmmmmmmmmmmmmmm—o- .\
Counter_updn_n_bit.vhdl 2 - v i i
il P 3 -- counter_updn_n_bit_th.vhdl Project Directory
bl Setup_examplesdc 4 -- No Selection A
5 -- created: 3/ 8
6 -- by: johnsontimoj Vv Library
7 -—rev: 0 i i
8 —— Basic Functions
9 -- testbench for up down counter DSP
10 -- of counter_updn_n_bit.vhdl
i% - Interface Protocols
i i v = ﬂ = __T______T ______________________
=S Sompbio 2 13 Tibrary ieee; Memary Interfaces and Controllers
~ 14 use jeee.std_logic_1164.all;
Task 15 Processors and Peripherals
16 Hentity counter_updn_n_bit_tb is A
v Compile Design 17 = ge}r"l‘fer'ic( P University Program
18 N: natural := 8
v Analysis & Synthesis 19 L 3 e Search for Partner IP
[~ . ) 20 -- no port entry - testbench
Edit Settings vl 21 end entity; "
7 > 7 2 + Add.
= Q
gl an Q| A (A | 88 Find... | |8 Find Next
i}
= || Type ID Message ~
(i ] Running Quartus Prime Analysis & Elaboration
i ) Command: quartus_map --read_settings_files=on --write_settings_files=off Setup_example -c Setup_example --analysis_and_elaboration
1 18236 Number of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PARALLEL_PROCESSOF
© 20030Parallel compilation is enabled and will use 2 of the 2 processors detected
© 12021 Found 2 design units, including 1 entities, in source file counter_updn_n_bit.vhd]
© 12127 Elaborating entity "Counter_updn_n_bit" for the top Tevel hierarchy
1 20013 Ignored 185 assignments for entity "DELO_Lite" -- entity does not exist in design
i ) Quartus Prime aAnalysis & Elaboration was successful. 0 errors, 187 warnings
m -~ R R R R R R A R R A R A R R A A R AR R AR AR R R R R R R e
o || € >
@
g Systern (1) Processing (14)
Ln1 Col1 VHDL File 100% 00:00:04
Common 20
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* Enter your TB

Continue to use generics in TB
TB signals in all caps

Define a constant for the clock PER
(no absolute times used)

-- counter_updn_n_bit_tb.vhdl

-- created: 3/17/18
-- by: johnsontimoj
-- rev: 0

-- testbench for up down counter
-- of counter_updn_n_bit.vhdl

Tibrary ieee;
use ieee.std_logic_1164.a11;

entity counter_updn_n_bit_tb 1is
generic(
N: natural := 8
J;

-- ho port entry - testbench
end entity;

narchitecture testbench of counter_updn_n_bit_tb is

signal CLK: std_logic;
signal RSTB: std_Tlogic;
signal DIR: std_Togic;

signal CNT: std_Togic_vector((N - 1) downto 0);

constant PER: +time := 20 ns;

component counter_updn_n_bit

generic ( n NATURAL := 8 );
port
C .
i_rstb IN STD_LOGIC;
i_clk IN STD_LOGIC;
i_dir IN STD_LOGIC,
o_cnt OUT STD_LOGIC_VECTOR({(n - 1) downto 0)

’
end component;

DUT: counter_updn_n_bit
generic map(

h => N
D)
port map(

i_cTk => CLK,
i_rstb => RSTB,
i_dir => DIR,
o_cnt => CNT
);

21
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* Enter your TB

Separate clock, reset and run processes

Could be0, 1, 2, .... Run processes

-- Clock process

i clock: process -- note - no sensitivity list allowed
begin
CLK <= '0"';

wait for PER/2;
y infinite: Toop
CLK <= not CLK; wait for PER/Z;
end Toop;
end process;

-- Reset process
i reset: process -- note - no sensitivity 1list allowed
begin
RSTB <= '0O'; wait for 2*PER;
RSTB <= '1"; wait;
end process reset;

-- Run Process

i run: process -- note - no sensitivity list allowed
begin
-- initialize inputs
DIR <= '0';

-- wait for reset
wait for 2*PER;

-- run code

end architecture;

22
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* Enter your TB

* Elaborate the design

« With the original vhdl design set as the top level entity (not the
xxxx_tb.vhdl design)

e Select Processing = Start = Start Analysis and Elaboration

* This causes Quartus to check the Test Bench code along
with the original vhdl design

Common 23 © tj



* Setup your simulation

* Use the ModelSim Testbench Setup notes as a guide

Category:

General
Files
Libraries
¥ 1P Settings
IP Catalog Search Locations
Design Templates
¥ Operating Settings and Conditions
Voltage
Temperature
Compilation Process Settings
Incremental Compilation
™~ EDA Tool Settings
Design Entry/Synthesis
Simulation
Board-Level
¥ Compiler settings
VHDL Input
Verilog HOL Input
Default Parameters
Tirming Analyzer
Assembler
Design Assistant
Signal Tap Logic Analyzer
Logic Analyzer Interface
Power Analyzer Settings
SSM Analyzer

Specify options for generating output files for use with other EDA tools

Tool name: | ModelSim-Altera
O run gate-level simulation automatically after compilation
EDA Metlist Writer settings

Format for output netlist | VHDL <

Cutput directory: |simulation/modelsim

[] Map illegal HDL characters

Options for Power Estimation

[[] Generate Value Change Dump (VCD) file script  Script Settings. ..

Design in:

More EDA Netlist Writer Settings
NativeLink settings
O MNone
® Compile test bench: | Counter_updn_n_bit_tb
O Use script to set up simulation:

O Script to compile test bench:

More NativeLink Settings...

W Buy Software OK

] Enable glitch filtering

Cancel

T | TestBenches...

Reset

Apply Help

=" Edit Test Bench Settings

Edit test bench settings for the selected

test bench.

Test bench name: |Counter_updn_n_bit_tb

Top level module in test bench: |Counter_updn_n_bit_tb

[ Usetestbench to perform VHDL timing simulation

me in test bench:

Design ins

Simulation period

NA

O Run simulation until all vector stimuli are used

® End simulation at: | 10300 ns

Test bench and simulation files

File name: |
File Name Library HOL Version
Counter_updn_... Default
OK Cancel

Add
Remove
Up

Down

Properties. .

Help

Common
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* Run your simulation

* Tools 2 Run Simulation Tools =2 RTL Simulation

M ModelSim - INTEL FPGA STARTER EDITION 10.5b

File Edit View Compile Simulate Add Wave Tools Layout

Bookmarks Window Help

|8-38=8. 85| ftew F osdAEBHAC Do tdtIL-AS
J Layout |Simulate ﬁ H LA R R R | |
| L&t |aaenan|

&l sim - Default =
¥ ‘Instance

= :”gﬁ-”ﬂd"-"-b--- Jeounter_updn_n_bit_th/CLK
+

@ cock Jeounter_updn_n_bit_th/RSTB | | [ [
o reset Jeounter_updn_n_bit_th/DIR ( { ! | | |
@ rn £ fcounter_updn_n_bit_th/CNT e e e C e e e e T e
M standard
B textio
M std_logic_1164
B numeric_std

i

hive) i H & x|
Name

Now 300 ns
I — 2

@ Library EISIm I ﬂj;‘_l | I‘| |ﬂJ__’ g t

-4 Transcript tioss H
# view signals
# .main pane.objects.interior.cs.body.tree
# run 10300 ns

VSIM 23>

Neowe 10 3NN ne  Nelta: 2 <im: leauinter 1indn n hit th 25 Nne tn 1NR1S ne
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* Verify your design

Reset &
Count up

Wrap up &
Count down

| count up

Wrap down

signal names visible

Common
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* Flow

MyDesign_tb.vhdl

Specifications Design Verification g X Verification
(Requirements) (Schematic or HDL) (RTL Simulation) pping (Hardware)

MyDesign.vhdl MyDesign_de10.vhdl

Common 27 © tj



* Create DE10 implementation HDL
* File > New - VHDL File

This should be the same name as
your design file with _de10 added

foo_nbit.vhdl
foo_nbit_tb.vhdl
foo_nbit_de10.vhdl

* File = Save As and give it an informational file name

Ok Quartus Prime Lite Edition - D:/GDrive/MSOE/Commen/Quartus_Projects/Common_Project/Setup_example - Setup_sxample

File Edit View Project Assignments Processing Tools Window Help

O~ g  » C [ 1/ SESOTP+ 5 OQEOH 9

ntity name to "Counter_updn_n_bit_del0"

New file is visible

<

Project Navigator El Files v Q@@ x| G counter_updn_n_bit_detovhdl* B 4 Compilation Report - Setup_example |IP Catalog pax
Fies a8 i 0 %) \ 3
. u gEEMN&RM L) %8 = :
t Counter updn n bit del10.vhdl; T hd ,‘ Installed IP
E% Counter_updn_n_bit_tb.vhdl g ¥ Project Directory
% Counter_updn_n_bitvhdl 4 Mo Selection A
m 5
e Setup_example.sdc 6 ~ Library
7
8 Basic Functions
9
10 DSP
%% Interface Protocols
i =48 x
[l ESEpEto 2 13 Memaory Interfaces and Controllers
14
Task ~ 15 Processors and Peripherals
16 s
~ P Compile Design 17 University Program
18
v Analysis & Synthesis 19 e Search for Partner IP
20
W Edit Settings w21
( > < + Add..
*
| Al 0 A4 N | mEmd.. &8 Find Next
i}
= | Type ID Message
@ 125061 changed top-level design entity name to "Counter_updn_n_bit"”
© 22036 successfully Taunched nativeLink simulation (quartus_sh -t "c:/intelfpga_Tlite/18.0/quartus/common/tcl/internal/nativelink/gnativesim.tcl” —rtl

gk execution see the NativeLink log file D:/GDrive/MsOE/Common/Quartus_Projects/Common_Project/setup_example_nativeldq

System (4) Processing (14)

100% 00:00:04
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* Set the Top Level Entity

 _Right click on the del0 file in the Files window
e Select Set as Top Level Entity

(T Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Cuartus_Projects/Common_Project/Setup_sxample - Setup_sxample

BB

File Edit View

D =] E .-‘ ") Setup_example

Project Assignments Processing  Tools Window Help

>+ 5OAOHE 9

Praject Navigatar E Files v aln@ x| & compilation Report - Setup_example € counter_updn_n_bit_de10.vhdl* ||p Catalog nax
Files = & = @ - 267 — |
. | {t |z P 268 = -
B Counter_uprin n hit et bl v i installed IP
b Open
Counter_uj = “ Project Directory
Counter uj Remove File from Project o
abe]
Setup_exar [ set as Top-Level Entity Ctrl+Shift+V ¥ Library
Basic Functions
Create AHDL Include Files for Current File
DSP
Create Symbol Files for Current File
| Interface Protocols
Tasks Create Verilog Instantiation Template Files for Current File
Memory Interfaces and Controllers
Create VHDL Component Declaration Files for Current File
Processors and Peripherals
v P Ccor Properties University Program
18
~ P Analysis & Synthesis 19 e Search for Partner IP
20
W edit Settings vl 21
< > < + Add.
x
Al @ A& A A <<Filters> M rind. 8 Find Next
q
= | Type ID Message
@ 125061 changed top-level design entity name to "Counter_updn_n_bit"”
© 22036 successfully launched nativerink simulation (quartus_sh -t "c:/intelfpga_lite/18.0/quartus/common/tcl/Internal/nativelink/gnativesim.tcl” --rtl
© 22036 For messages from NativeLink execution see the NativeLink log file D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example_nativeli
@ 125061 changed top-level design entity name to "Counter_updn_n_bit_del0"
)
IR >
i
% | GSystem(4)  Processing (14)
Sets the current file entity as the top-level entity for the next compilation 100% 00:00:04
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* Enter your DE10 design

Edit View Project Assignments

" Bl

N d

Project Navigator E Files

Files

Counter_updn_n_bit_de10.whdl
Counter_updn_n_bit_tb.vhdl
Counter_updn_n_bitvhdl

¢ Setup_examplesdc

88

(b Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example

Help

» # #
Setup_example T L é&@

& Counter_updn_n_bit_detovhd B & Compilation Report - Setup_example

ENRMBOTY S

Search altera.com

>+ OO 9

a| x

X

i

[Calv Il e W, VR N o

Compilation

Task
~ P compile Design
v P Analysis & Synthesis

B Edit Settings

counter_updn_n_bit_del0. vhdl

created: 3/1
by: johnsonti
rev: 0

DE10 implementation for up down counter
of counter_updn_n_bit.vhd

Uses a 3 Hz clock divider, sw0 for reset

swl for the dir input
and LEDs for the count output

Tlibrary ieee;
use jeee.std_logic_1164.all;

Bentity counter_updn_n_bit_del0 is

port(
CLOCK_50: in std_logic;

hd J Installed IP

¥ Project Directory

Mo Selection Aw:

™ Library

Basic Functions

DsP

Interface Protocols

Memory Interfaces and Controllers
Processors and Peripherals

University Program

e Search for Partner [P

| M Eind.. A Find Next

Add...

Ill-nmx|"

Type ID Message

125061 Cchanged top-Tlevel design entity name to "Counter_updn_n_bit"”

i}

© 22036 successfully launched NativeLink simulation (quartus_sh -t
© 22036 For messages from NativeLink execution see the NativeLink log file D:/GDriv
i ]

125061 changed top-Tlevel design entity name to "Counter_updn_n_bit_del0"

"c:/intelfpga_lite/18.0/quartus/common/tc1/internal /nativelink/gnativesim.tcl” --rtl
/MSOE /Common,/Quartus_Projects/Common_Project/Setup_example_nativeld

|Message5

Systemn (4) Processing (14)

Ln1 Col1

100% 00:00:04
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Use qgsf pin names for the top level
I/Os

* Enter your DE10 design

El ______________________________

-- counter_updn_n_bit_del0.vhdl

-- created: 3/17/18
-- by: johnsontimoj
-- rev: 0

-- DE10 implementation for up down counter
-- of counter_updn_n_bit.vhdl
-- Uses a 3 Hz clock divider, sw0 for reset
-- swl for the dir 1input

-- and LEDs for the count output

Tibrary ieee;

architecture hardware of counter_updn_n_bit_del0 is

signal CLK_SIG: std_logic; -- Intermediate clk signal

component clk_3Hz

port(
i_cTk_50MHz IN STD_LOGIC,
i_rstb IN STD_LOGIC;
) o_clk_3Hz OUT STD_LOGIC

end component;

component counter_updn_n_bit

use jeee.std_Tlogic_1164.al11; generic ( n : NATURAL := 8 );
Hentity counter_updn_n_bit_del0 is port
C P qoacser g st ooy e e
Sw: in std_Togic_vector(l downto 0); i dir . IN STD:LOGICE
| LEDR : out std_Togic_vector(7 downto 0) s o_cnt : OUT STD_LOGIC_VECTOR((n - 1) downto 0)
[end Entity; end Component: .

Common
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* Enter your DE10 design

CK: c1k_3Hz

g port map(
i_cTk_50
i_rstb
o_cTk_3H

);

g port map(_
1_
i_
i_
o_

. );

end architecture;

MHz

z

clk
rstb
dir
cnt

DUT: counter_updn_n_bit

=>
=>
=>
=>

CLOCK_50,
sw(0),
CLK_SIG

CLK_SIG,

sw(o),

sw(l),

LEDR (7 downto 0)
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* Create a clock divider
 File 2 New = VHDL File

* File = Save As and give it an informational file name

<

w file is visible

de10"

(b Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example
Eile Edit Wiew Project Assignments Processing Tools Window Help
A ’ » . . .
Nr= 9 0 » ¢ 1/ SEO DT> 55 SOQEAVE @

Project Navigator E| Files vjafge <| ¢ clk_3Hz.vhdl* B & compilation Report - Setup_example ||F’ Catalog ng =
Files = & L[.I] = 267 = o %
- 208 T A =
B Clk_3Hz.vhdl = ~ g Installed IP

-~
B™® Counter_updn_n_bit_de10.vhdl g “ Project Directory
ot Counter_updn_n_bit_tb.vhdl 4 No
3
ot Counter_updn_n_bit.vhdl I ¥ Library
7
jat) Setup_example.sdc 8 Basic Functions
o Dpsp
%% Interface Protocols
i =08 %
[E2= STy H 2 alg) Memory Interfaces and Controllers
14
Task ~ 15 Processors and Peripherals
16 .
v Compile Design 17 University Program
18
~ P Analysis & Synthesis G e Search for Partner IP
20
W Edit Settings vl 22 v

= > < > + Add..

| x |

ol (O [4 4 (A ] 88 Eind.. | 88 Find Next

il
= | Type ID Message
© 125061 changed top-level design entity name to "counter_updn_n_bit”
C 028 o ad NativeLink simulation (quartus_sh -t "c:/intelfpga_lite/18.0/quartus/common/tcl/internal/nativelink/qnativesim. tcl"” --rt]

iveLink execution see the NativeLink log file D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example_nativeld
ign entity name to "Counter_updn_n_bit_

System (4)

Processing (14)

Ln23 Col1 VHDLFile 100%

00:00:04
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e Create 3Hz clock divider

E| ______________________________________
-- c1k_3hz.vhdl

-- created 2/20/18
-- tj

-- 3Hz clock divider for use with DE10 Labs

-- assumes a 50MHz external clock

-- Inputs: rstb, clk_50MHz
-- Outputs: clk_out

Tibrary ieee;
use ieee.std_logic_1164.al1T;
use ieee.numeric_std.all;

nentity clk_3hz 1is

H port (
i_c1k_50MHz : 1in std_logic;
i_rstb : in std_logic;
o_clk_3Hz : out std_logic

-);

end entity;

34
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This is the key 3Hz parameter

e Create 3Hz clock divider

darchitecture behavioral of clk_3hz is
3 -
-- constants and parameters

constant CLOCKS_PER_HALF_PERIOD: sﬁgne*:::)downto 0) := to_signed((((50_000_000 / 2)(:::)-— 2),(::>;

3 —_—

-- internal signals ////////,)V
signal cnt: S'igne downto 0);

| signal clk_sig:  std_1og7c; ‘__—_—___—""""—-————————_____________ If you change the frequency — be
abegin sure to check the vector sizes

3 process(i_c1k_50MHz, 1i_rsth)
begin

-- reset
if (i_rstb = '0') then
cht <= CLOCKS_PER_HALF_PERIOD;
clk_sig <= '0";
elsif (rising_edge(i_c1k_50MHz) ) then
cht <= ¢cnt - 1;
-- check if half way
3 if (cnt < 0) then
chnt <= CLOCKS_PER_HALF_PERIOD;
clk_sig <= not clk_sig;
- end if;
- end 1if;
end process;

Ml b

3 —_—
-- Output logic

o_clk_3Hz <= clk_s1ig;

-end behavioral;
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* Compile
* Check the design syntax, create RTL, Place and Route
e Processing = Start Compilation

(S Quartus Prime Lite Edition - D:/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example

File Edit View Project Assignments

OfF<=d 1

Processing  Tools

Window Help

Setup_example

PLLL

>PoPOndH D

|IP Catalog

ne =

Check for timing issues

¥ Project Directory

¥ Library
Basic Functions
DsP

Interface Protocols

Memory Interfaces and Controllers

Processors and Peripherals

il Rie a0

332123 periving Clock uncertainty.
332146 worst-case setup slack is 1B.626

332146 worst-case hold slack is 0.166

paths to report

332140 No Removal paths to report
332146 wWorst-case minimum pulse width slack is 9.464
332102 pesign is not fully constrained for setup requirements

332102 pesign is not fully constrained for t

Please refer to report_sdc in tl

10ld requirements

~ - _ L

Project Mavigator g Files ~ogd = & Counter_updn_n_bit_de10.vhdl @ Compilation Report - Setup_example (£
Files Table of Contents A Flow Summary
BB ik 3hzvhdl 5 Flow Summary A (| & <<Filt
E® Counter_updn_n_bit_de10.vhdl FA Flow settings Flow Status Successful - Sat Jun 23 08:4 *
E}% Counter_updn_n_bit_tb.vhdl FH Flow Non-Default Global Settings Quartus Prime Version 18.0.0 Build 614 04/24/201
E}% Counter_updn_n_bitvhdl A Flow Elapsed Time Revision Name Setup_example
Eﬁ Setup_example.sdc FH Flow os summary Top-level Entity Name counter_updn_n_bit_de10
=l Flow Log Family MAX 10
Analysis & Synthesis Device 10M50DAF484CT7G
Tasks Compilation MEE L Fitter Timing Models Final
Task ~ Assembler Total logic elements 35/ 49,760 (< 1%
v P Compile Design Timing Analyzer Total registers 34
EDA Netlist Writer Total pins
P Analysis & Synthesis Type b Message
O Flow Messages Total virtual pins
P Fitter (Place & Route) 9 v . o
M rlow Siinnracced Mascaoes Trtal meamans hits
> < > i ]
Nl i ]
3 | Al A [A] (A [7 <riters | 88 Eind.. | |88 Find Next © 332140 No Recovery
]
= || Type ID Message i ]
[ ] Quartus Prime Timing Analyzer was successful. 0 errors, 196 warnings o
[ ) Running Quartus Prime EDA Netlist wWriter o
(i ] command: quartus_eda --read_settings_files=off --write_settings_files=off o
1 18236 Number of processors has not been specified which may cause overloading o _
' 10905 Generated the EDA functional simulation netlist because it is the only supported netlist type for this device.
204019 generated file setup_example.vho in folder "D:/GDrive/MsoE/Common/Quartus_projects/common_pProject/simulation/modelsim/" for Epa simulation te
i ] P. P ] ]
i ) Quartus Prime EDA Netlist writer was successful. 0 errors, 2 warnings
293000 quartus Prime Full Compilation was successful. 0 errors, 572 warnings
i ] P s 9
@
¥«
a
E System Processing (138)

Review all Warnings

100% 00:05:18 ‘
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* Compile
* Check the Flow Summary

Quartus Prime Version
Revision Mame
Top-level Entity Name
Family

Device

Timing Models

Total logic elements
Total registers

Total pins

Total virtual pins

Total memory bits
Embedded Multiplier 9-bit elements
Total PLLs

UFM blocks

ADC blocks

<éucce55fui>-‘lon Jun 25 117:20:24 2018

18.0.0 Build 614 04/24/2018 SJ Lite Edition

MAX 10

( >/ Correct Part Number
T0MS0DAF484CTG

Final

35\ 49,760 (<1 %)

11/ 160(3 %)

Check success

Setup_example Correct Top Level Design

37

Check to make sure
utilization makes sense
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 Verify the RTL
* Tools = Netlist Viewers =2 RTL Viewer

Common

Clock divider
i

Note: this IS NOT sufficient for a
design report — you need to show
RTL for all blocks you created

Counter

/

\

Counter_updn_n_bitDUT

/

38

clk_3Hz:CK
, |
CLOCK_BOD i clk 50MHz o clk 3Hz i clk
SW[1..0] D_r[) i_rstb 1 i_dir[ o cnt[7..0] D LEDR[7..0]
I 0 i_rstb /V
Correct 1/O
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* Flow

Specifications
(Requirements)

Common

MyDesign_tb.vhdl

Design

Verification
(RTL Simulation)

\
(Schematic or H[>
\ /

MyDesign.vhdl

39

/

Synthesis

Place &
Route

Verification

Mapping (Hardware)

MyDesign_del0.vhdl
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* Program the board

* Connect the DE10 board to computer

e Tools = Programmer
* Point to the compiled output file xxxx.sof

Start

» Programmer - Dv/GDrive/MSOE/Common/Quartus_Projects/Common_Project/Setup_example - Setup_example - [Set...

File Edit View Processing

W seart
il Stop
8 Auto Detect

Delete

™ Add File..

P Change File...

W save File

* Add Device...

i Up

k] Down

Tools Window Help

; Hardware Setup... | |[EElgGEHEg IR0

[J Enable real-time ISP to allow background programming when available

Mode: |JTAG

- [m} x

b Progress

100% (Successful)

File Device Checksum Usercode Program/  Verify  Blank- Examine
Configure Check
output_files/Setup_exa.. 10MSODAF484 002756F9 002756F9
£ >
TTTTTTTT
. A
H O
TOI H H
— b :
H H
T0MS0DAF484
TDO

FS
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* Verify Operation
* video

y

P imammm

&
O
1\ A

u\m\ i \\ ¥

\\\\\\u ‘\\ \\‘

N&f“l“rﬂm
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